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I.   About Wavector 
 
Wavector provides a modern set of ocean wave analysis tools in a convenient user-
friendly software package for scientists, engineers, technicians and students. Based on 
the proven XWaves ocean wavefield analysis technology, Wavector provides a cost-
effective solution for wave data analysis and visualization requirements. 

 

Key features of Wavector include: 

• Read in data from most popular instruments and models 
• Download and process data from US national wave archives (NODC and NDBC) 
• Versatile interactive exploration and  plotting of results 
• Powerful wave partitioning capability for wind sea and swell separation 
• Wave system climatology analysis 
• Convenient data editing and smoothing utilities 
• Export data to user-defined tables (EXCEL, MATLAB, or Text) 

Wavector is completely GUI-driven and packaged as a stand-alone application ready to 
go to work for you! 

 

 

II.  Program Installation 
 

System Requirements 
Wavector is designed to run as a stand-alone application in the MS Windows O/S 
environment on a personal computer.  

 



Wavector Installation 
To install from a CD follow these simple steps: 
 

1. Decide where to install Wavector on your computer hard disk.  The program will 
operate from any location that you have read/write access to. 

2. Drag or copy the Wavector folder from the CD-ROM to the selected location on 
your PC hard disk 

3. Initiate the installer by double-clicking on the wavector_install icon.  Follow the 
on-screen instructions.  A required Matlab Runtime Compiler (MCR) will be 
installed.  The installation process can take several minutes.  

4. Once installation is completed, double-click on the Wavector icon to launch the 
program.  The first time you launch Wavector it takes a few extra minutes for the 
system to set up and initialize.  When the Wavector splash screen appears, you are 
ready to go!  Access the program user guide through the Help pull-down menu. 

 

 

III.  Quick-Start Guide 
 

What follows is a typical Wavector data exploration and analysis session.  Work through 
these steps to quickly become familiar with most Wavector capabilities and features. 

 

1. Launch the Wavector application by double-clicking on the application icon. 

2. Load a data set by either (a) loading the provided sample Wavector data file 
(test_data.mat) using either the Open File toolbar button or the Open Wavector 
File command in the File pull-down menu; or (b) importing data from your 
instrument or national data archive using the Load Raw Data command in the File 
pull-down menu.  Note:  For first-time use we suggest experimenting with the 
provided test data! 

3. Explore your un-processed data using the Data View module.  Use the Data View 
toolbar buttons and the Layout and Options pull-down menu commands to 
customize your displays.  Right-click on any plot title to select a new plot type 
and further modify plot features. 

4. Open the Data Utilities Module using either the Data Utilities toolbar button or 
the Data Utilities command in the Options pull-down menu.  The Data Utilities 
Module allows you to remove records, smooth, interpolate, subset and sub-sample 
your data. 

5. Explore your Data Utilities  results using the Data View module 



6. Process your data using either the Process Data toolbar button or the Process 
Data command on the Options pull-down menu.  This performs a wave 
partitioning and swell tracking analysis on your data. 

7. Explore your processed data using the Data View module.  Note there are several 
new plot types and layout pages available with processed data.  Save a set of plots 
in your favorite format using the Export Image command in the File pull-down 
menu. 

8. Prepare and export a custom data file using the Data Export Wizard command in 
the Tables pull-down menu.  You select which data fields to save and identify an 
output data format (Text, EXCEL or MATLAB). 

9. Save your Wavector processed data file for future recall using either the Save 
toolbar button or the Save command in the File pull-down menu. 

10. Exit Wavector using the Exit Wavector command in the File pull-down menu or 
by clicking on the close box in the upper right of the Wavector window. 

 

 

IV.  Loading Data 

 

 
Wavector Start-Up Screen 

 

Data Formats 



Wavector is designed to read in and processes a temporal series of non-directional (1D) 
or directional (2D) wave spectra data from a specific observing station or numerical wave 
model output location.   Wind speed and direction time series data are also read if 
included in the data file.  When loading a data set for the first time, a variety of common 
data formats can be read, including 

• NORTEK wave data files *.wft  
• Datawell Waverider buoy files *.spt 
• Triaxys buoy files *.dirspec 
• Wavescan buoy data files 
• WavescanTS files 
• National Oceanographic Data Center (NODC) Type 291 Data Records 
• National Data Buoy Center (NDBC) real-time (45-day) data files 
• Coastal Data and Information Program (CDIP) spectra files 
• Oceanweather, Inc wave model spectrum files 
• WaveWatch III model station files 
• SWAN model station files 
• Esp2D files 
• Generic ASCII data files *.csv 
 

A unique feature is that Wavector will download and process NODC and NDBC 
monthly files directly over the World-Wide Web (WWW).  This connects Wavector to 
the complete US National archive of real-time and historical wave observations. 

Furthermore, Generic MATLAB file formats allow the MATLAB user to convert wave 
spectrum data from any source into a useable form.  Custom data formatters are available 
upon request. 

Once a series of wave spectra records has been read into Wavector, it can be saved as a 
Wavector data file for repeated easy loading at any time.  All processed results are saved 
along with original data in the Wavector data file. 

 

 

V. Data View  



 
Data View’ 2D Spectra’ Plot Layout 
 
Data View is a versatile data plotting and exploration tool for visualizing Wavector 
imported and processed data.  Features include 10 different page layout options with 1 to 
6 plots per page and several different plot libraries to select from.  As your data analysis 
proceeds, the number of display options in Data View increases.  Image and movie-file 
export capability is included. 

As described below, Data View features are accessible through a variety of interactive 
plot features, toolbar commands, and pull-down menu commands.   

Data View Interactive Plot Features 
Plot Menu – Right-Click on a plot to access the menu for that axes.  All the available 

plots for the current data are available here as well as a variety of display options 
(described below).  

Note: As data processing proceeds, additional plot options will become available. 
Record Scrolling – The scroll bar at the bottom of the Data View window allows the user 

to scroll forward and back through the data records.  A dashed vertical red line will 
appear in all time-series plot to identify the time of the currently active record. 

Record List – Right clicking anywhere in Data View will bring up a menu of plot 
commands that includes “View Record List”.   This opens a Record List window that 
provides additional user controls for exploring data.  Specific controls for the Record 
List include: 



Up Arrow: View Next Record 
Right Arrow: Same as Up Arrow 
Down Arrow: View Previous Record 
Left Arrow: Same as Down Arrow 
Page Up: View Next Record Section if Time Axis is Zoomed in 
Page Down: View Previous Section if Time Axis is Zoomed in 
Home: View First Record 
End: View Last Record 
 
View button – Time series plots zoom into display only selected records. 

View All button – Time series plots display all records 
 

Select Record Using Time Series Plot – See Time Axis Mouse Control in the Options 
pull-down menu below. 

Rotate 3D Plots Using Mouse – Left Click the left or right side of a 3D plot to rotate 
clockwise or counter clockwise,  Shift + Left Click (or Right + Left Click) the top or 
bottom of a 3D plot to rotate up or down. 

 

Data View Toolbar Commands 
A toolbar across the top of the plot page has the following click-tools.  Simply click on 
each toolbar icon to activate the command.  A listing of the toolbar commands appears in 
the figure below.   



 
Data View Toolbar Icons.  Not shown:  Process Data icon (circular arrow). 
 
Data View Pull-Down Menu Commands 
File Menu – for loading and saving data, plots and movies 

• Load Raw Data – Select available data source to read and format unprocessed 
wave spectra files.  

• Open Wavector File – Select and load processed data files from previous 
Wavector sessions.   

• Save As – Save Wavector data file with a new filename 

• Save – Save Wavector data with existing filename 

• Copy – Copy an image of the current window to the clipboard 

• Export – Save an image file, MATLAB figure file or movie file to disk 

• Page Setup, Print Preview, Print – Standard printing dialogue boxes 

• Clear All Data – Clear all data currently stored in Wavector and return to the 
Start-Up screen. 



• Exit Wavector – Quit the Wavector program and close all windows. 

Settings  

• Color Scheme – Set background and text colors for all windows and plots 

Layout 

• Templates – Display Plot Layout Templates 

• Default Plots – Pre-defined plot layouts, including the following options: 
  - Spectra Plots – Default layout for unprocessed data 
  - Wave System Plots – Default layout for processed data 
  - Climatology Spectra Plots – Default Climatology layout for unprocessed data 
  - Climatology Wave System Plots – Default Climatology layout for processed 
data 

• Saved Layouts- User-defined page layouts.  Save custom page layouts by name 
and recall them through this menu command. 

Options 

• Data Utilities – Open the Data Utilities Module 

• Process Data – Initiate wave spectra partitioning and swell tracking analysis 

• Time Axis Mouse Control – Toggles the ability to select records to display using 
the mouse on time series plots.  A vertical reference bar is displayed. 

• Plot Axis Scaling – Set 1D and 2D spectrum plots to logarithmic or linear Scale, 
this option also appears in the Plot Menu 

• Enable Pierson-Moskowitz – Toggles the display of a Pierson-Moskowitz (PM) 
model spectrum with the Frequency Spectrum (1D) plot.  The PM spectrum is 
computed from the wind speed for each record. 

• Enable 2D Contour Plot Legend – Toggle a colorbar plot scale for the 2D 
Contour Plot 

 

Tables 

The Tables pull-down menu provides the following option for displaying and 
exporting tables generated by Wavector: 

• Export Wizard – Custom export of Wavector data.  See Data Export Wizard. 
 

Help 

• Help Contents – Display Wavector Help Table of Contents 

 

 



VI.   Data Utilities  
 

 

The Utilities Module in Wavector provides a variety of database manipulation tools for 
user wave data.  These tools allow the user to add or remove data records, apply record 
smoothing or sub-sampling, change the frequency and angular resolution of wave 
spectrum records, and change the data set name. 

Launching the Utilities Module 

Once data has been loaded into Wavector (see Loading Data), the Data Utility Module 
can be launched by either activating the Data Utilities toolbar command or by selecting 
the Data Utilities command in the Option pull-down menu.  Since the data utilities tools 
make changes to the data in memory, a Save Data window appears and provides the 
opportunity to save user data before proceeding.  If the user has already processed these 
data, the Save Data window will warn the user that wave system information will be lost.  
This is because the data utilities only operate on the wave spectrum records, not 
processed wave system data.  However if only using the Rename utility then no data will 
be lost.  When finished with the Data Utilities, Wavector will automatically re-process 
the data to generate new wave system information. 

When the Utilities Module is launched an interactive Data Utilities window appears.  
Record listing boxes show the years, months, days, and records represented in the user 
data.  All utility functions are activated from this window.  A list of the available 
commands, and instructions for their operation, appear below. 

Utility Commands 

Smooth Records 
The Smooth Records utility performs a weighted running average over the wave 
spectra loaded into Wavector.  This utility is activated by clicking on the Smooth 
Records button in the Data Utilities Window.  A message box will request the user to 
type in the desired wave spectrum smoothing interval in hours.  Over this specified 
duration, Wavector will perform a weighted running average of the input directional 
wave spectra.  For example, a 4-h smoothing window will smooth all spectra 
occurring up to 2-h prior and 2-h after each observation time.  This feature is quite 
helpful for measured spectra, and will help reduce data processing time by 
eliminating spurious peaks.   

SubSample File 
The SubSample utility reduces user data file sizes by saving only those records that 
occur at a specified time interval. This utility is activated by clicking on the 
SubSample File button in the Data Utilities Window.  A message box will request the 
user to type in the desired interval in hours for record sub-sampling.  Wavector will 



remove records that fall in-between this interval.  For example, if a 3-h data 
subsample interval is selected for data that is provided hourly, every third record will 
be saved.  This feature is helpful for decreasing the size of large files, and will reduce 
data processing time by providing fewer records to process.   

Spectral Resolution 
The Spectral Resolution utility is used to change the frequency range, frequency 
resolution, and directional resolution of the directional wave spectra.  This utility is 
activated by clicking on the Spectral Resolution button in the Data Utilities Window.  
A Spectral Resolution GUI will open that allows the user to specify the frequency and 
angle bins in the output directional spectra.  Input spectra are linearly interpolated to 
the requested resolution.   

The use of this feature can greatly reduce output file sizes and save on data 
processing times for large data sets.  Measured data are often saved at a very high 
directional resolution.  Try setting your angular resolution at 10 or 15 degrees, 
corresponding to 36 or 24 angle bins.   

Append File 
The Append File utility is used to add another data set to the current user data loaded 
in Wavector.  This utility is activated by clicking on the Append File button in the 
Data Utilities Window.  A browser window will open to allow the user to select a data 
file to append.  Selected files must have observation times that either precede or 
follow the observation times of the user data in memory.  Once a file to append is 
selected, click on Open to execute the utility.  Once the utility is complete, the 
window display of available data records is updated. 

Subset File 
The Subset File utility allows the user to create a new data file from a subset of the 
user data in memory.  The user should first interactively select the range of data to be 
subset.  Data can be selected by year, month, day, or record attributes by clicking and 
dragging the cursor over the desired range, shift-clicking a range, or double-clicking 
on a particular attribute.  Control-clicks can be used to select different data segments 
to subset.  Once the desired range is selected, clicking on the Subset File button 
activates the utility.  Once the utility is complete, the window display of available 
data records is updated. 

Remove Records 
The Remove Records utility allows the user to extract and discard records from the 
user data in memory.  The user should first interactively select the range of data to be 
removed.  Data can be selected by year, month, day, or record attributes by clicking 
and dragging the cursor over the desired range, shift-clicking a range, or double-
clicking on a particular attribute.  Control-clicks can be used to select different data 
segments to subset.  Once the desired range is selected, clicking on the Remove 
Records button activates the utility.  Once the utility is complete, the window display 
of available data records is updated. 

Rename 



The Rename utility allows the user to change the name of the user data in memory.  
Clicking on Rename opens up an input dialog box with the current name.  The user 
can either change the name and click OK to save or click Cancel to keep the existing 
name.  Selecting rename will not cause any processed data to be lost. 

 

 

VII.  Data Export Wizard 
 
The Export Wizard is a data export utility for Wavector that allows the user to develop 
and save custom output data table files.   Features include selection of desired output 
fields and specification of the desired output format (ASCII, EXCEL or mat-file).  
Furthermore the Export Wizard will allow these custom table formats to be named and 
saved for future recall. 
 
Using the Export Wizard 
 
The program is launched from the Export Wizard command in the Wavector Tables pull-
down menu.  This opens up the Export Wizard GUI.  The various command options are 
listed in the table below.   
 
Export Wizard GUI Command Options 
  
Command Function Description 
Named Settings Pull-Down 

List 
Names of user-provided settings 

Update Push Button Update current named setting 
Save New Push Button Save a new named setting 
Reset Push Button Revert to original settings 
Delete Push Button Delete named setting 
Run Push Button Run the export data function 
Cancel Push Button Cancel operation and return to previous Module 
View Fields Push Button Opens a listing of available field names and their 

descriptions 
Select Fields Push Button Opens the Select Export Data Fields GUI (see below) 
Export Format Pull-Down 

List 
Select format of export data file (ASCII, EXCEL or 
mat file) 

Number of Wave 
Systems 

Pull-Down 
List 

Select from 1-5 output wave systems.  Option only 
available for Wave Systems and Spectral Fit data.  

Data Header 
Options 

Selection 
Boxes 

Select desired header information for export files (see 
below) 

? Push Button Open Export Wizard Help page 



 
 
The Data Header Options selection boxes allow the user to select the desired data header 
information to be written along with the data to the export data file.  The following 
options are available.   
 
 
Header Options Description 
Data Set Name Name given to this data set (can be changed in Utilities Module) 
Metadata Misc. Information on Dataset:  1D or 2D,  water depth, latitude, 

longitude, number of records 
Processing_History Lists the data processing history as recorded by Wavector 
Field_Descriptions List of field names and descriptions 
Field_Names Field names across top of data columns 
 
 
The Export Wizard GUI will allow the user to select from lists of available field names.  
The available fields are described in the following tables. 
 
Standard Data Export Fields 
 
Field  Description 
Date     Format: YYYYMMDD HHMM 
WS  Wind speed (m/s) 
WD Wind Direction (deg from true north) 
Hs      Significant wave height (m) of total spectrum 
Tp      Peak period (s) of total spectrum 
T01      Mean (zero-crossing) period (s) of total spectrum 
L01     Wave length (m) of total spectrum calculated from T01 
Cp    Phase speed (m/s) of total spectrum calculated from Tp 
Dp      Peak direction (deg from true north) of total spectrum 
Dm      Mean direction (deg from true north) of total spectrum 
Sp      Spectral spread (deg) of total spectrum 
 

 
Processed Data Export Fields 
 
Field Description 
par       Partition identifier (0= windsea, 1-n = swells) 
sys System group identifier (0= windsea, 1-n = swells groups) 
Hsi      Significant wave height (m) of system  
Tpi     Peak period (s) of system  
T01i     Mean (zero-crossing) period (s) of system  
L01i     Wave length (m) of system calculated from T01i 
Cpi   Phase speed (m/s) of system calculated from Tpi 



Dpi     Peak direction (deg from true north) of system 
Dmi      Mean direction (deg from true north) of system 
Spi     Spectral spread (deg) of system 
 
 
Notes:  Wind data are only included if available in wavedat 

 Directional and spread fields are not included for type 1D data. 
Key:  i = 0 for windsea, i>0 for swells, in order of highest energy to lowest   

 
Export Data Formats 
 
ASCII (text) and EXCEL data tables are exported as column-oriented time series lists.  
Each wave record has a single row in the table. The order of the data columns is identical 
to the sequential order of the fields in the above tables.  For Wave System data, multiple 
wave systems as specified by the user will appear as repeating sets of columns on a given 
row: 
 
Date/Time;  full spectrum fields; system 1 fields; system 2 fields; system 3 fields;   etc. 
 
The Export Wizard allows an additional export option for a MATLAB mat-file data 
structure (xdat).  The data structure is organized as column-oriented vectors and has 
header and field names identical to those listed in the above tables: 
 

xdat.Date 
xdat.Hs 
xdat.Tp 
etc… 

 
For multiple wave systems the ‘i’ in the field names will be replaced with the sequential 
wave parition number (for example, hs1, hs2, and hs3 for dominant, secondary and 
teriary wave systems).  This occurs in both the table header field names (if selected for 
output) and the mat-file structure field names. 
 

 

VIII.  Additional Help 
 
Wavector help and product support is available through our web site at 
www.WaveForceTechnologies.com 

Licensed users are entitled to email support at help@WaveForceTechnologies.com 
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